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1.  INTRODUCTION

The PowerCore is an easy-to-use core module with a networkable

microprocessor system that has an optional onboard config-

urable power supply. In addition to two standard preconfigured

models, PowerCore FLEX™ modules can be built on a quick-turn

basis based on customer-selected options. Customers can select

memory, Ethernet, power supply, and other features to suit their

individual needs without having to pay for unneeded features.

The PowerCore is designed to 

plug into a motherboard 

designed by the customer. A 

50-pin connector brings the 

various I/Os, the I/O bus, and 

the power supplies to the cus-

tomer’s motherboard. Three 

snap-in plastic standoffs pro-

vide sturdy mechanical support.

The PowerCore is supported by 

powerful Dynamic C develop-

ment platform that includes 

extensive libraries to support 

networking and the Internet.

PowerCore modules are programmed over a standard PC serial port through a program-

ming cable supplied with the Tool Kit, and can also be programmed through a USB port 

with an RS-232/USB converter, or directly over an Ethernet link via a RabbitLink.
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1.1  PowerCore Features

1.1.1  Basic Features

• Small size: 2.35" × 4.00" × 1.08"

(60 mm × 102 mm × 28 mm) 

• 39 configurable 5 V tolerant general-purpose I/O lines

• Three additional digital inputs, two additional digital outputs

• Five 3.3 V CMOS-compatible serial ports with a maximum asynchronous baud rate up 

to 6.45 Mbps. Three ports are configurable as a clocked serial port (SPI), two ports are 

configurable as HDLC serial ports, and one ports is configurable as an SDLC serial port. 

One of the serial ports is normally dedicated as a programming port.

• 512K flash memory for storing instructions

• 256K static RAM for data

• Rabbit 3000® microprocessor running at 25.8 MHz. The Rabbit 3000 includes many 

powerful I/O devices such as serial ports, and precision pulse generation and 

measurement.

• 50-pin connector brings I/O and I/O bus to customer’s motherboard

• Battery backable time/date clock

1.1.2  Options

• Ethernet including RJ-45 connector (10/100 compatible)

• Clock speed 51.6 MHz

• Analog precision ramp generator that can be used in conjunction with low-cost 

comparators to create rugged A/D converter inputs

• Larger 512K SRAM memory for data

• Second 512K flash memory

• 1 Mbyte serial flash memory that implements file storage

• Coin cell battery to back up the SRAM and the onboard time/date clock

• Onboard +5 V DC switching power supply rated at 1 A or 2 A

• Triac support with AC zero-crossover detection

• Wi-Fi Add-On Kit to enable Wi-Fi interface
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• External power-supply options for PowerCore module and motherboard

user-supplied regulated +5 V DC is supplied to the PowerCore module from the motherboard—the 

+5 V is regulated down to +3.45 V for driving the nominal 3.3 V components on the PowerCore; 

the motherboard can draw from the 3.45 V supply

user-supplied unregulated DC (8–40 V) is supplied to the PowerCore module from the mother-

board or via the locking power connector at J3—requires onboard +5 V switching regulator @ 1 A 

or 2 A maximum output; the +5 V is regulated down to +3.45 V for driving the nominal 3.3 V com-

ponents on the PowerCore; the motherboard can draw from both the 3.45 V and the +5 V regulated 

supplies

AC from two-lead transformer is supplied to the PowerCore module that has half-wave rectifier 

and filtering capacitor, includes zero-crossover detection to synchronize software drivers for triac 

support, two-lead transformer with untapped secondary winding may be used—the resulting DC 

then passes to the onboard +5 V switching regulator @ 1 A or 2 A maximum output, and is further 

regulated to +3.45 V; additional filtering capacitors may be needed on motherboard if high unregu-

lated DC current will be drawn

AC from three-lead center-tapped transformer is supplied to the PowerCore module that has full-

wave rectifier and filtering capacitor, includes zero-crossover detection to synchronize software 

drivers for triac support, transformer with tapped secondary winding required—the resulting DC 

then passes to the onboard +5 V switching regulator @ 1 A or 2 A maximum output, and is further 

regulated to +3.45 V; additional filtering capacitors may be needed on motherboard if high unregu-

lated DC current will be drawn

AC from two-lead transformer is supplied to the PowerCore module that has full-wave bridge recti-

fier and filtering capacitor, no zero-crossover detection or triac support, transformer with untapped 

secondary winding may be used—the resulting DC then passes to the onboard +5 V switching reg-

ulator @ 1 A or 2 A maximum output, and is further regulated to +3.45 V; additional filtering 

capacitors may be needed on motherboard if high unregulated DC current will be drawn
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1.2  Standard Configurations and PowerCore FLEX Options

There are two preconfigured PowerCore models. Table 1 below summarizes their main 

features.

If the standard models do not serve your needs, flexible PowerCore FLEX options can be 

configured to meet your needs.

Appendix A provides detailed specifications for the PowerCore modules.

Table 1.  Standard PowerCore Production Models

Feature  PowerCore 3800  PowerCore 3810

Microprocessor Rabbit 3000 running at 51.6 MHz Rabbit 3000 running at 25.8 MHz

Ethernet 10/100 compatible 10Base-T interface —

SRAM
512K program (fast SRAM)

+ 512K data
256K data

Flash Memory 

(program)
512K 512K

Flash Memory

(mass data storage)

1 Mbyte

(serial flash)
—

Current Limits for 

Onboard +5 V DC 

Voltage Regulators

2 A 1 A
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1.3  PowerCore FLEX Advantages

• Fast time-to-market using a fully engineered, “ready-to-run/ready-to-program” micro-

processor core.

• Competitive pricing when compared with the alternative of purchasing and assembling 

individual components.

• Easy C-language program development and real-time debugging with integrated 

Dynamic C® environment.

• Onboard regulated power supply, which can be used to power external circuits.

• Program download utility (Rabbit Field Utility) and cloning board options for rapid 

production loading of programs.

• Generous memory size allows large programs with tens of thousands of lines of code, 

and substantial data storage.

• Integrated Ethernet port for network connectivity, with royalty-free TCP/IP software.

• Ideal for network-enabling security and access systems, home automation, HVAC 

systems, and industrial controls.

• Can use either AC or DC power sources.

• Onboard analog circuits (AC zero-crossover detection allows triac control, ramp gener-

ator allows 10-bit A/D conversion with temperature sensor to allow for temperature 

compensation).



6 PowerCore FLEX

1.4  Development and Evaluation Tools

The PowerCore Tool Kit contains the hardware you need to use your PowerCore module.

• PowerCore Prototyping Board.

• 48 V AC, 1 A center-tapped transformer.

• Programming cable with 10-pin header and DE9 connections, and integrated level-

matching circuitry.

• Mounting standoffs.

• Dynamic C CD-ROM, with complete product documentation on disk.

• Getting Started instructions.

• Accessory parts for use on the Prototyping Board.

• Rabbit 3000 Processor Easy Reference poster.

• Registration card.

Figure 1.  PowerCore Tool Kit
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PowerCore FLEX™

Tool Kit Contents

The PowerCore FLEX Tool Kit contains the following items:

• PowerCore Prototyping Board.

• 48 V AC, 800 mA center-tapped transformer. A transformer compatible with power outlets in continental 

Europe is included with kits sold overseas.

• 10-pin header to DB9 programming cable with integrated level-matching circuitry.

• Mounting standoffs.

• Dynamic C CD-ROM with complete product documentation on disk.

• Getting Started instructions.

• A bag of accessory parts for use on the Prototyping Board.

• Rabbit 3000 Processor Easy Reference poster.

• Registration card.

Installing Dynamic C®

Insert the CD from the Development Kit in your PC’s CD-ROM drive. If the instal-

lation does not auto-start, run the setup.exe program in the root directory of the 

Dynamic C CD. Install any Dynamic C modules after you install Dynamic C.

���	�
��	��
	�
�����������

�����

��
��

��
�

��

��
�
 �

�


	
��


	
��


	
��

��
�

��
� �� �� �� �� �� ��

�� ��
	�


	
��


	
��


	
��


	
��

��
�

�� �� �� �� �� ��



�� !�




��

 !�




��

 !


�� �� �� �� �� ��

��
�

�� �� �� �� �� �� ��
�

��
�
 �

�


	
��


	
��


	
��

��
�

��
�

�� ��
	�


	
��


	
��


	
��


	
��

��
�

"�
�

"�
�

��� ���

���
��

��
�

���
��

��
�

"�
�

"�
�


�
�


�
�

"�
�

"�
�

���

"�
�

���

���

�#

��#

��
��

��
��

��
��

��
$

!�
�	�	�

��

��
�

�

�

�

�

�

�

�

�

�

�

�

�

���
"�

��
�

"�


�� ��

���

�� ��
�

��
�

���

���

��
�

��
�

��
�

��
�

��
�

��
�

��
�

��
�

��
��

��

�

��

�

��

�

!�

!�

��
	�

�

�

�

�

��
�

��
�

��
�

��
�

��
�

��
�

��
�

��
�

��
�

��
�

��
�

�� ��
�

��
�

��
�

��
�

�	
�

�	
�

��
��

��
�

��
�

�

�

��
�

��
�

��
�

��
�

��
�

��
�

��
�

��
�

��
�

��
�

��
�

��
�

��
�

�	
�

�	
�

��
%

������
���
���������


�
#

��
�

��
� ���

��� 
�
�

���
�
��


��
���


��
���

�$

��

��
�
�

�
��

$

��#���


�
� ���

���
���
�

�

���

��

���

���


��

���

���


�#

��
�

��
�

���

��
�

��
�

"�


�
$


�
�


�

��

��


�

��


�

��

"�

��
	� �


�

�

�

��
�

��
�

��
�

��
�

��
�

��
�

��
�

��
�

��
�

��
�

��
� �� ��
�

��
�

��
�

��
�

�	
�

�	
�

�
 ��
�

��
�

�

�


�


#

��
%

�

��
�

�

�

�

�

��
�

��
�

��
�

��
�

��
�

��
�

��
�

��
�

��
�

��
�

��
�

��
�

��
�

��
�

��
�

�	
�

�

�

�

�
�


�

�	���	������ 
�


$


��


�
�

��

��
"�


�
��
�


��
���


�
�

��
�

��
�

&�

��#

��$

���

&�


�
$

��

��
�


��

&�

��
�

��
� ���&�

��

���

���

&�

��
� ���

��
�


�� ��
&$

��# ��$


�
�

&# 
�
�

&�

��

&�

��$
���

&��

��#

���
���

��
�

"�

���

��"� 
��

&�� ��
�

��� &��

���

����

�"���

�"���

�
��

�
��

�
�

������

�"���

�"���

������

���
��

!�

!�

���

��
�


�
�

&��

�
�

���

���

��	

��	

���

�������	�

���

�	�������
���


��
�

��
��

��
�

�� ��
�

��


�
�

��$


�$

�#

��

��'���

����



User’s Manual 7

1.4.1  Software

PowerCore FLEX modules are programmed using version 9.20 or later of Rabbit Semi-

conductor’s Dynamic C. A compatible version is included on the Tool Kit CD-ROM.

Rabbit Semiconductor also offers for purchase add-on Dynamic C modules including the 

popular µC/OS-II real-time operating system, as well as point-to-point protocol (PPP), 

Advanced Encryption Standard (AES), FAT file system, Secure Sockets Layer (SSL), 

RabbitWeb, and other select libraries. In addition to the Web-based technical support 

included at no extra charge, a one-year telephone-based technical support module is also 

available for purchase. Visit our Web site at www.rabbit.com for further information and 

complete documentation for each module, or contact your Rabbit Semiconductor sales 

representative or authorized distributor.

1.4.2  Wi-Fi Add-On Kit

Rabbit Semiconductor also offers a Wi-Fi Add-On Kit for PowerCore FLEX modules 

consisting of a PowerCore Interposer Board, a Wi-Fi CompactFlash card with a Compact-

Flash Wi-Fi Board, a ribbon interconnecting cable, and the software drivers and sample 

programs to help you enable your PowerCore module with Wi-Fi capabilities. The Power-

Core Interposer Board is placed between the PowerCore module and the PowerCore 

Prototyping Board so that the CompactFlash Wi-Fi Board, which holds the Wi-Fi Com-

pactFlash card, can be connected to the PowerCore-based system via the ribbon cable pro-

vided.

Visit our Web site at www.rabbit.com or contact your Rabbit Semiconductor sales repre-

sentative or authorized distributor for further information.

1.4.3  Online Documentation

The online documentation is installed along with Dynamic C, and an icon for the docu-

mentation menu is placed on the workstation’s desktop. Double-click this icon to reach the 

menu. If the icon is missing, use your browser to find and load default.htm in the docs 

folder, found in the Dynamic C installation folder.

The latest versions of all documents are always available for free, unregistered download 

from our Web sites as well.
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2.  GETTING STARTED

This chapter explains how to set up and use a PowerCore module

with a PowerCore Prototyping Board.

NOTE: It is assumed that you have a Tool Kit. If you purchased a PowerCore FLEX 

module by itself, you will have to adapt the information in this chapter and elsewhere to 

your test and development setup.

2.1  Install Dynamic C

To develop and debug programs for PowerCore FLEX modules (and for all other and 

Rabbit Semiconductor hardware), you must install and use Dynamic C.

If you have not yet installed Dynamic C version 9.20 (or a later version), do so now by 

inserting the Dynamic C CD from the Tool Kit in your PC’s CD-ROM drive. If autorun is 

enabled, the CD installation will begin automatically.

If autorun is disabled or the installation otherwise does not start, use the Windows 

Start | Run menu or Windows Disk Explorer to launch setup.exe from the root folder 

of the CD-ROM.

The installation program will guide you through the installation process. Most steps of the 

process are self-explanatory.

Dynamic C uses a COM (serial) port to communicate with the target development system. 

The installation allows you to choose the COM port that will be used. The default selec-

tion is COM1. You may select any available port for Dynamic C’s use. If you are not cer-

tain which port is available, select COM1. This selection can be changed later within 

Dynamic C.

NOTE: The installation utility does not check the selected COM port in any way. Speci-

fying a port in use by another device (mouse, modem, etc.) may lead to a message such 

as "could not open serial port" when Dynamic C is started.

Once your installation is complete, you will have up to three new icons on your PC desk-

top. One icon is for Dynamic C, one opens the documentation menu, and the third is for 

the Rabbit Field Utility, a tool used to download precompiled software to a target system.

If you have purchased any of the optional Dynamic C modules, install them after installing 

Dynamic C. The modules may be installed in any order. You must install the modules in 

the same directory where Dynamic C was installed.
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2.2  Hardware Connections

There are three steps to connecting the PowerCore Prototyping Board for use with 

Dynamic C and the sample programs:

1. Attach the PowerCore module to the Prototyping Board.

2. Connect the programming cable between the PowerCore module and the workstation PC.

3. Connect the power supply to the PowerCore module.

2.2.1  Attach Module to Prototyping Board

Turn the PowerCore module so that the notched corner is on the top left as shown in 

Figure 2 below. Snap in at least one standoff as shown below and then insert the module’s 

J4 header into the PC1 socket on the Prototyping Board. The notched corner at the top left 

corner of the PowerCore module should face the same direction as the corresponding 

notch outline below it on the Prototyping Board

Figure 2.  Install the PowerCore Module on the Prototyping Board

NOTE: It is important that you line up the pins on header J4 of the PowerCore module 

exactly with the corresponding pins of the PC1 socket on the Prototyping Board. The 

header pins may become bent or damaged if the pin alignment is offset, and the module 

will not work. Permanent electrical damage to the module may also result if a mis-

aligned module is powered up.

Press the standoff into its corresponding hole and press the module’s pins firmly into the 

Prototyping Board socket.
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2.2.2  Connect Programming Cable

The programming cable connects the PowerCore module to the PC running Dynamic C to 

download programs and to monitor the PowerCore module during debugging.

Connect the 10-pin connector of the programming cable labeled PROG to header J2 on 

the PowerCore module as shown in Figure 3. There is a small dot on the circuit board next 

to pin 1 of header J2. Be sure to orient the marked (usually red) edge of the cable towards 

pin 1 of the connector. (Do not use the DIAG connector, which is used for a nonprogram-

ming serial connection.)

Attach the DE9 connector end of the programming cable to a COM (serial) port on the PC.

NOTE: Be sure to use the programming cable (part number 101-0542) supplied with this 

Tool Kit—the programming cable has blue shrink wrap around the RS-232 converter 

section located in the middle of the cable. Programming cables from other Rabbit Semi-

conductor kits might not work with PowerCore modules.

Figure 3.  Connect Programming Cable and Power Supply

NOTE: Some PCs now come equipped only with a USB port. It may be possible to use 

an RS-232/USB converter (Part No. 540-0070) with the programming cable supplied 

with the PowerCore FLEX Development Kit. Note that not all RS-232/USB converters 

work with Dynamic C.
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2.2.3  Connect Power

When all other connections have been made, you can connect power to the PowerCore 

module. In most cases where a locking power connector is stuffed at J3, connect the lock-

ing plug from the wall transformer to the J3 locking connector on the PowerCore module, 

taking care to line up the polarized tab on the locking plug with the locking connector as 

shown in Figure 3.

Plug in the wall transformer. The DS3 and DS4 yellow and green LEDs on the Prototyping 

Board located near the RESET button should light up. The PowerCore module and the 

Prototyping Board are now ready to be used.

If you selected one of the FLEX configuration options (Options 1 and 2 in Appendix D.1.1) 

for regulated or unregulated DC power supplied from outside the PowerCore module, no 

locking connector is stuffed at J3 on the PowerCore module. Instead, either regulated +5 V 

DC is supplied to the PowerCore from your motherboard via pins 5 and 6 of header J4, or 

unregulated DC power is supplied via pins 1 and 5 of header J4, depending on which 

option you selected. The voltage range for unregulated DC power is established by your 

selection of a voltage regulator in Option 2 as explained in Appendix D.1.1.

NOTE: This provision of external DC power is not possible when you are using the 

PowerCore Prototyping Board, which has no provision to supply powerto the Power-

Core module. Any external DC power must come from a motherboard of your own 

design for use with one of these FLEX options.

NOTE: The RESET button is provided on the Prototyping Board to allow a hardware 

reset without disconnecting power.

CAUTION: It is important that power is connected in the order specified in these 

instructions—connect the locking plug from the wall transformer to the J3 locking 

connector on the PowerCore module before you plug in the wall transformer. This is 

important for your safety because of the high AC voltages present and to avoid possi-

ble damage to your PowerCore module.

CAUTION: The heat sinks on the PowerCore module can become very hot. Avoid 

any contact with them.
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2.3  Starting Dynamic C

Once the PowerCore module is connected as described in the preceding pages, start 

Dynamic C by double-clicking on the Dynamic C icon or by double-clicking on 

dcrabXXXX.exe in the Dynamic C root directory, where XXXX are version-specific 

characters. Dynamic C uses the serial port on your PC that you specified during 

installation.

If you are using a USB port to connect your computer to the PowerCore module, go to the 

Options > Project Options dialog box and select “Use USB to Serial Converter” on the 

Communications tab.

2.4  Run a Sample Program

Use the File menu to open the sample program PONG.C, which is in the Dynamic C 

SAMPLES folder. Press function key F9 to compile and run the program. The STDIO win-

dow will open on your PC and will display a small square bouncing around in a box.

If Dynamic C appears to compile the BIOS successfully, but you then receive a communi-

cation error message when you compile and load a sample program, it is possible that your 

PC cannot handle the higher program-loading baud rate. Try changing the maximum 

download rate to a slower baud rate as follows.

• Locate the Serial Options dialog in the Dynamic C Options > Project Options > 

Communications menu. Select a slower Max download baud rate.

If a program compiles and loads, but then loses target communication before you can 

begin debugging, it is possible that your PC cannot handle the default debugging baud 

rate. Try lowering the debugging baud rate as follows.

• Locate the Serial Options dialog in the Dynamic C Options > Project Options > 

Communications menu. Choose a lower debug baud rate.

If Dynamic C cannot find the target system (error message "No Rabbit Processor 

Detected."):

• Check that the PowerCore module is powered correctly — the red and yellow LEDs on 

the Prototyping Board should be lit when the PowerCore module is mounted on the Prototyp-

ing Board and the wall transformer is plugged in.

• Check to make sure you are using the PROG connector, not the DIAG connector, on the 

programming cable.

• Check both ends of the programming cable to ensure that they are firmly plugged into 

the PC and the programming port on the PowerCore module.

• Ensure that the PowerCore module is firmly and correctly installed in its socket on the 

Prototyping Board.

• Select a different COM port within Dynamic C. From the Options menu, select 

Project Options, then select Communications. Select another COM port from the list, 

then click OK. Press <Ctrl-Y> to force Dynamic C to recompile the BIOS. If Dynamic C 

still reports it is unable to locate the target system, repeat the above steps until you locate 

the active COM port.
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2.5  Where Do I Go From Here?

If the sample program ran fine, you are now ready to go on to other sample programs and to 

develop your own applications. The source code for the sample programs is provided to allow 

you to modify them for your own use. This manual also provides complete hardware refer-

ence information and describes the software function calls for the PowerCore FLEX mod-

ules, the Prototyping Board, and the optional LCD/keypad module.

For advanced development topics, refer to the Dynamic C User’s Manual and the 

Dynamic C TCP/IP User’s Manual, also in the online documentation set.

2.5.1  Standalone Operation of the PowerCore Module

Once the PowerCore module has been programmed successfully, remove the program-

ming cable from the programming connector and reset the PowerCore module. The Pow-

erCore module may be reset by removing, then reapplying power, or by pressing the 

RESET button on the Prototyping Board if it is connected to the Prototyping Board. The 

PowerCore module may now be removed from the Prototyping Board for end-use 

installation.

2.5.2  Technical Support

NOTE: If you purchased your PowerCore through a distributor or through a Rabbit Semi-

conductor partner, contact the distributor or partner first for technical support.

If there are any problems at this point:

• Use the Dynamic C Help menu to get further assistance with Dynamic C.

• Check the Rabbit Semiconductor Technical Bulletin Board at 

www.rabbit.com/support/bb/.

• Use the Technical Support e-mail form at www.rabbit.com/support/.

CAUTION: Disconnect power to the PowerCore module or other boards when 

removing or installing your PowerCore module to protect against inadvertent 

shorts across the pins or damage to the PowerCore module if the pins are not 

plugged in correctly. Do not reapply power until you have verified that the Power-

Core module is plugged in correctly. 
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3.  RUNNING SAMPLE PROGRAMS

To develop and debug programs for the PowerCore (and for all

other Rabbit Semiconductor hardware), you must install and use

Dynamic C.

3.1  Introduction

To help familiarize you with the PowerCore FLEX modules, Dynamic C includes several 

sample programs. Loading, executing and studying these programs will give you a solid 

hands-on overview of the PowerCore’s capabilities, as well as a quick start using Dynamic C 

as an application development tool.

NOTE: The sample programs assume that you have at least an elementary grasp of the C 

programming language. If you do not, see the introductory pages of the Dynamic C 

User’s Manual for a suggested reading list.

In order to run the sample programs discussed in this chapter and elsewhere in this manual,

1. Your PowerCore module must be plugged in to the Prototyping Board as described in 

Chapter 2, “Getting Started.”

2. Dynamic C must be installed and running on your PC.

3. The programming cable must connect the programming header on the PowerCore 

module to your PC.

4. Power must be applied to the PowerCore module.

Refer to Chapter 2, “Getting Started,” if you need further information on these steps.

To run a sample program, open it with the File menu, and then compile and run the sample 

program by selecting Run in the Run menu (or press F9). The PowerCore module must be 

in Program Mode (see Figure 8) and must be connected to a PC using the programming 

cable.

More complete information on Dynamic C is provided in the Dynamic C User’s Manual.
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3.2  Sample Programs

Of the many sample programs included with Dynamic C, several are specific to the 

PowerCore FLEX modules. Sample programs illustrating the general operation of the 

PowerCore FLEX modules, serial communication, the serial flash, A/D conversion, D/A 

conversion, and hardware accessories such as a temperature sensor and triacs are provided 

in the SAMPLES\PowerCoreFLEX folder. Each sample program has comments that 

describe the purpose and function of the program. Follow the instructions at the beginning 

of the sample program. Note that the PowerCore module must be installed on the Proto-

typing Board when using the sample programs described in this chapter. TCP/IP sample 

programs are described in Chapter 6, “Using the TCP/IP Features,” and sample programs 

for the optional LCD/keypad module are described in Appendix C.

3.2.1  I/O

The following sample programs can be found in the SAMPLES\PowerCoreFLEX\IO 

folder.

• DIGIN.c—Demonstrates how to read digital inputs using the digIn function call. 

Press switches S2 and S3 on the Prototyping Board to change the logic levels for IN0 

and IN1 as displayed in the Dynamic C STDIO window.

• DIGOUT.c—Demonstrates the control of sinking and sourcing digital outputs. Connect 

100 Ω load resistors from the +5 V supply at pin 6 on header J4 or from the ground at 

pin 2 on header J2 as indicated in the table below.

Digital Output Load Resistor +K

Sinking

OUT0
+5 V to OUT0

(+5 V to J2 pin 3) +K to +5 V

(J2 pin 1 to +5 V)
OUT1

+5 V to OUT1

(+5 V to J2 pin 4)

Sourcing

OUT2
GND to OUT2

(GND to J2 pin 5) +K to + 5 V

(J2 pin 1 to +5 V)
OUT3

GND to OUT3

(GND to J2 pin 6)



User’s Manual 17

These connections are illustrated below.

After you compile and run this program, select an output channel and logic level via the 

Dynamic C STDIO window. You can see the logic level with a voltmeter connected to 

the output channel you selected.

• LED.c—Demonstrates the use of the digital inputs by turning LEDs DS5 and DS6 on 

the Prototyping Board on and off.

�
%�#����	��	�

���	�
��	

�����������

�����

�
�

��

�
�

�

�
�

�
�

�



�

�



	

�
�



	

�
�



	

�
�

�
�

�

�
�

�

�
�

�
�

�
�

�
�

�
�

�
�

�
�

��
	

�



	

�
�



	

�
�



	

�
�



	

�
�

�
�

�

�
�

�
�

�
�

�
�

�
�

�
�



�� !�






�
�

 !
�






�
�

 !



�
�

�
�

�
�

�
�

�
�

�
�

�
�

�

�
�

�
�

�
�

�
�

�
�

�
�

�
�

�

�
�

�



�

�



	

�
�



	

�
�



	

�
�

�
�

�

�
�

�

�
�

��
	

�



	

�
�



	

�
�



	

�
�



	

�
�

�
�

�

"
�

�

"
�

�

��� ���

���
��

�
�

�

���
��

�
�

�

"
�

�

"
�

�



�

�



�
�

"
�

�

"
�

�

���

"
�

�

���

���

�#

��#

�
�
�
��

�
�
��

�
�
��

�
$

!� �	�	� ��

���

�

�

�

�

�

�

�

�

�

�

�

�

���
"�

�
�
�

"�


�� ��

���

��

�
�

�
�

�
�

�
�
�

�
�
�

�
�

� �
�
�

�
�

� �
�
�

�
�

�

�
�

�

�
�

�

�
�

�

�
��

�

�
�



�

�
�



�

�
�



�

!�

!�

��
	

�

�



�

�



�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�
�

�

�
�

�

�
�

�

�
�

�

�
	

�

�
	

�

�
�
��

�
�

�

�
�

�

�



�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
	

�

�
	

�

�
	

�

	


��

�



�

�



�

�
�

%
� �����
���
���������



�
#

�
�
�

�
�
�

���

���



�
� �
�
$

���

��


��
���


��

���

�#

�$�
�


��

�
�
�

�
�
$

��#���



�
� ���

���
���



�
�

���


��

���

���


��

���

���


�#

�
�
�

�
�
�

���

�
�
�

�
�
�"�



�
$


��


�

��

��


�

��


�

�
�

"�

��
	

�

�



�

�



�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�
�

�

�
�

�

�
�

�

�
�

�

�
	

�

�
	

�

�
�
��

�
�

�

�
�

�

�



�


�


#

�
�

%
�

�
�

�

�



�

�



�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
�

�

�
	

�

�



�

�



�


�


�

�	���	������ 
�


$


��



�
�

��

��
"�



�
�
��
�


�
�
��
�


�
�

�
�
�

�
�
� &�

��# �
�

 ���

&� 

�
$

��

�
�
�


��

&�

�
�
�

�
�
�

���&�
��

���

���

&�

�
�
� ���

�
�
�



�
�

��

&$

��# ��$



�
�

&# 

�
�

&�
��

&�

��$
���

&��

��#

���
���

�
�
�

"�

���

��"� 
��

&�� �
�
�

��� &��

���

��

�"���

�"���

�
��

�
��

�
�

���

�"���

�"���

���

�
��

!�

!�

���

���



�
�

&��

�
�

���

���

��	

��	

���

�������	�

��

���

!��

���
��

"�

!�

��

"��

��

!�

��

�� ��

���


�

�

���


�

"��

����

!��
�

�

!
�

�

�
�

�



�

�



�
�

�
�

�
�

�
�

�
�

�
�

�
�



�

�

"��


��


�#

����
�

�

�
�

�

����


��

������$
���

�#

��

���
��#

��



�

�

��

���
��



�

�

"��"��

�

�
�

�
�

�
�

#



�
�



�

#

"
�

"
�


�#

��

"
�

��


� 
�
��

�
�

�
�

�
�

�
�

�
�

$

"� 

�

�
�

�
�



�

$

"$

�
�

�
�

�
#

���

���
���

���



�

�

���



�

�

�� �����

���

��


�$

���

���



�

�

"#

��$

���
"�

"�

�
�

$



�
�



�

�
�
�


# 
�
&� ���

���

���



�

�

��

��

��������#


�



$�$

�#

��

�
�
�

���



�

�

�
�

�

�
�

#

��$ 

�

�



�
�

���

��

���

���

���

���

�
�
�



�
�



�
�

&�

���

���
���

�
�

�

��$

"
�

� ���

���

���


�"���� �(��)


�"���� �(��)


��

�
�

�

���

�
�

����
�
��


	Contact us
	PowerCore FLEX™ User's Manual
	Table of Contents
	1. Introduction
	1.1 PowerCore Features
	1.1.1 Basic Features
	1.1.2 Options

	1.2 Standard Configurations and PowerCore FLEX Options
	1.3 PowerCore FLEX Advantages
	1.4 Development and Evaluation Tools
	1.4.1 Software
	1.4.2 Wi-Fi Add-On Kit
	1.4.3 Online Documentation


	2. Getting Started
	2.1 Install Dynamic C
	2.2 Hardware Connections
	2.2.1 Attach Module to Prototyping�Board
	2.2.2 Connect Programming Cable
	2.2.3 Connect Power

	2.3 Starting Dynamic C
	2.4 Run a Sample Program
	2.5 Where Do I Go From Here?
	2.5.1 Standalone Operation of the PowerCore Module
	2.5.2 Technical Support


	3. Running Sample Programs
	3.1 Introduction
	3.2 Sample Programs
	3.2.1 I/O




